Icon Extractor for Windows 95/NT
Copyright © 1995-1998 by Gregory Braun. All rights reserved.

Overview
Icon Extractor for Windows 95/NT is a small utility that will allow you to load and display the ICON resources found in any disk
file or application program.

Icon Extraction
Icon Extractor allows you to select ICON resources to be saved as individual ICO files.

Clipboard Copying
Selected icons can also be copied directly to the MS Windows Clipboard as small bitmap images. From here they may easily be
pasted into most Icon Editor applications and utilities.

Drag & Drop Interface
You may also drag file icons directly on to the Icon Extractor’s main window to quickly open and view the ICON resources found
in the specified disk file.

File Formats
Icon Extractor reads DLL, EXE, ICO, ICL, IL and NIL icon file formats.

Desktop Locations

Icon Extractor’s location on the desktop is saved when the program is exited. Whenever you start Icon Extractor it will reappear
on the desktop where you last placed it. Icon Extractor property sheet locations are also stored and reused the next time they
are opened.

Taskbar Tray
Icon Extractor for Windows 95/NT can be optionally configured to place its program icon in the Taskbar Icon Notification Tray.
This option provides a simple means of keeping the taskbar button region clear for other running programs.



Installing Icon Extractor

Installation
To install Ilcon Extractor for Windows 95/NT on your computer simply create a new, empty folder and place the files;
ICONEX.EXE, ICONEX.HLP and ICONEX.CNT there.

ICONEX.EXE - The Icon Extractor Application
ICONEX.HLP - The Windows 95/NT Help File
ICONEX.CNT - The Help Contents File
To integrate Icon Extractor for Windows 95/NT with the MS Windows Explorer select the Icon Extractor Explorer Setup property

sheet while Icon Extractor is running.

Note If you have an earlier version of Icon Extractor for Windows 95/NT installed on your computer, simply replace the
ICONEX.EXE, ICONEX.HLP and ICONEX.CNT files with the newer versions.

Note The ICONEX.INI file is no longer used and can be deleted. The various application settings specified in the Icon Extractor
Options property sheet as well as the main window’s size and location on the desktop are now stored in the MS Windows 95/NT
System Registry.

Note Some earlier versions of Icon Extractor for Windows 95/NT included a ICONEX.WRI documentation file. This file has been
replaced by the ICONEX.HLP file and can now be deleted.

Warning If you rename the ICONEX.EXE file you must also rename the HLP file using the same basename. For example if you
change the Icon Extractor application file name to NewName.exe, rename the help file to NewName.hlp. Do not rename the
ICONEX.CNT file however. The HLP and CNT files must reside in the same folder as the Icon Extractor application file itself.



Configuring Icon Extractor

Icon Extractor Options
Select the File | Options menu item to display the Icon Extractor Options property sheet. This window will allow you to change
the various Icon Extractor program settings listed below.

Launch Multiple Instances
Check this item to allow more than one instance of Icon Extractor to be run on the desktop.

Reopen the Last File Used at Startup
Check this box to reopen the last file used when Icon Extractor is launched.

Show Tool Bar Tips
Check this item to display small popup tip windows when the mouse pointer is placed over toolbar ribbon pushbuttons. A short
description of the button currently beneath the mouse will be shown when this item is checked.

Place Icon in the Taskbar Tray
Check this item to display a small Icon Extractor program icon in the Taskbar Icon Notification Tray. If this item is selected and
the Icon Extractor window is minimized a button will not be added to the Taskbar, to restore the Icon Extractor window on the
desktop press the small icon in the taskbar tray instead. This option is available to keep the taskbar free for other running
programs.

Note When this option is selected, clicking on the Close box in the upper-right hand corner of the window title bar will
minimize Icon Extractor instead of closing the application. To quit Icon Extractor use the File | Exit menu command or the
Ctrl+Q keyboard shortcut.

Confirm Program Exit
Check this item to confirm quitting Icon Extractor for Windows 95/NT. When this option is selected you will be prompted to
confirm your intention to exit Icon Extractor and return to the MS Explorer desktop. This item is useful if you run Icon Extractor
from the tray and wish to avoid accidental exits when you right-click on the Icon Extractor tray icon.

SLR Camera Sound when Copying
Check this box to play an SLR camera shutter sound when copying selected icons to the MS Windows Clipboard.

Specify an Icon Editing Application
The Icon Editor you specify here will be opened when you press the Edit button on the toolbar ribbon. Specify the full drive
and path when defining your preferred icon editing utility, or press the browse [...] button to the right of the entry field to select
an icon editing program using the standard MS Windows File Explorer.

Specify a Background Color for Clipboard Copying
The color you specify here will be used as the background when copying selected ICON resources to the MS Windows
Clipboard. Press the Select button to open the standard MS Windows Color Picker.

Sounds with Warning Dialog Boxes
Check this box to play a short beep sound when Icon Extractor displays a warning dialog box or an error occurs.

OK
Press this button when you have completed your selection of Icon Extractor program options. When you press this button the
Icon Extractor Options property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the Icon Extractor Options property sheet without making any changes. If you have made any
changes to the option settings, and then press this button your changes will not be used, and your previous settings will
remain in use.

Help
Press this button to open the Icon Extractor Help window and go directly to the Configuring Icon Extractor topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the Icon Extractor
Options window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Reqistry.



Icon Extractor Explorer Setup

Icon Extractor Explorer Setup

Select the Help | Setup menu item to display the Icon Extractor Setup property sheet. This window will allow you to integrate
Icon Extractor for Windows 95/NT with the Microsoft Windows 95/NT Explorer. Use this command to create and remove MS
Explorer shortcuts.

Create a Start Menu Item
Check this item to create a Icon Extractor Start Menu entry. The Icon Extractor for Windows 95/NT program will be located in
the Software by Design folder on the Programs menu. This item will be disabled (grayed) if a lcon Extractor item already
exists in the Software by Design folder.

Remove this Start Menu Item
Check this item to remove the Icon Extractor entry located in the Software by Design folder on the Programs menu. This item
will be disabled (grayed) if a Ilcon Extractor item does not already exist in the Software by Design folder.

Create a Desktop Icon
Check this item to create a Icon Extractor for Windows 95/NT program icon on the Explorer desktop. This item will be disabled
(grayed) if a Icon Extractor desktop icon already exists.

Remove Icon from the Desktop
Check this item to remove the Icon Extractor for Windows 95/NT program icon from the Explorer desktop. This item will be
disabled (grayed) if a Icon Extractor desktop icon does not already exist.

Create a Startup Folder Item
Check this item to automatically run Icon Extractor for Windows 95/NT whenever Microsoft Windows is started. This option
creates a Icon Extractor program icon in the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a Icon
Extractor startup item already exists in the Startup folder.

Remove the Startup Folder Item
Check this item to remove Icon Extractor from the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a
Icon Extractor startup item does not already exist in the Startup folder.

OK
Press this button when you have completed your selection of MS Explorer shortcuts. When you press this button the Icon
Extractor Setup property sheet will be closed and the MS Explorer shortcuts you have selected will be created or removed.

Cancel
Press this button to close the Icon Extractor Explorer Setup property sheet without creating or removing any MS Explorer
shortcuts.

Help
Press this button to open the Icon Extractor Help window and go directly to the Icon Extractor Explorer Setup topic.



File Menu

File Menu Commands
The File menu provides commands to work with the icon files used by Icon Extractor. A short description of each item follows:

Open
Opens an existing icon file, and loads it for viewing. When this item is selected the standard MS Windows Explorer file
browser will be displayed, use this window to select the icon file you wish to work with. The Ctrl+O shortcut can be used for
this command.

Properties
Displays a small window showing file properties for the currently selected icon file. This window will display the file’s name,
folder location, size, last modification date and file access permissions. The Alt+Enter shortcut can be used for this
command.

Close
Closes the currently active icon file. The Ctrl+W shortcut can be used for this command.

Save Selection
Saves the currently selected icon as an individual ICO file. The Ctrl+S shortcut can be used for this command.

Options
Opens the |con Extractor Options property sheet and allows you to change Icon Extractor program settings. Use this
command to configure the Icon Extractor program.

Recent Files
This command displays a sub-menu containing up to 9 recently viewed icon libraries. Select a file name from this list to
quickly reopen a recently viewed icon file.

Exit
Closes the Icon Extractor program and returns control to the Explorer desktop. The Ctrl+Q shortcut can be used for this
command.

Tip Commonly used File commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Edit Menu

Edit Menu Commands
The Edit menu provides commands used to copy selected icons. A short description of each item follows:

Copy
Copies the currently selected ICON resource to the Clipboard. The icon will be converted into a small 32x32 pixel bitmap
image. From the Clipboard the image can be pasted into most popular Icon Editing applications and utilities. The Ctrl+C
shortcut can be used for this command.

Edit
Launches the Icon Editor you specified in the lcon Extractor Options property sheet. The Ctrl+E shortcut can be used for
this command.

Tip Commonly used Edit commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



View Menu

View Menu Commands
The View menu provides commands used to change Icon Extractor display options. These items provide a means of changing
the Icon Extractor window appearance. A short description of each item follows:

Previous Page
Use this command to display the previous page of ICON resources found in the current icon file. The PgUp shortcut can be
used for this command.

Next Page
Use this command to display the next page of ICON resources found in the current icon file. The PgDn shortcut can be
used for this command.

Minimize
Minimizes the Icon Extractor window to a button or icon on the taskbar. The Ctrl+Y shortcut can be used for this command.

Always on Top
Use this command to keep the Icon Extractor window top most on the desktop. When this item is checked the Icon
Extractor window will float above all other non-topmost windows on the desktop. This item is useful if you normally run Icon
Extractor with a small window that would be easily obscured by other applications. The Ctrl+T shortcut can be used for this
command.

Tip Commonly used View commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Help Menu

Help Menu Commands
The Help menu provides commands used to get help with Icon Extractor operations. A short description of each item follows:

Contents
Opens the Icon Extractor Help window and displays the Table of Contents. The F1 shortcut can be used for this command.

Search
Opens Icon Extractor Help and displays the Search window. You can use this window to search for specific lcon Extractor
help topics.

How to Use Help
Opens a Help window that explains how to use the MS Windows 95/NT Help program.

Register
Displays the Icon Extractor Shareware Registration Wizard. This wizard allows you to register Icon Extractor for Windows
95/NT for authorized use.

Setup
Displays the Icon Extractor Explorer Setup property sheet. This window provides options to integrate Icon Extractor with the
MS Windows Explorer. Use this window to create MS Explorer Start Menu items and desktop icons.

Web Site
Opens your web browser application and goes directly to the Software by Design web site on the Internet.

About Icon Extractor
Displays the Icon Extractor splash box. This window contains program information, the current version of Icon Extractor you
are running and a program copyright notice. Click the mouse anywhere in this window to close it

Tip Commonly used Help commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Toolbar Buttons

Tool Ribbon Buttons
Most commonly used Icon Extractor menu commands can also be quickly invoked by pressing a button on the toolbar ribbon
displayed at the top of the main window.

These buttons work exactly the same way as the corresponding menu items that they duplicate.

Open - Open an icon file for viewing

Save - Save the selected icon as an ICO file

Properties - Show the current icon file’s properties

Close - Close the currently active icon file

Copy - Copy the selected icon to the Clipboard

Edit — Open the default Icon Editor

Previous — display the previous page of icons
Next — display the next page of icons

Topmost — Make the Icon Extractor window topmost

Options - Open the |con Extractor Options dialog

Help - Open this Help file
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About - Show Icon Extractor splash box

Tip If the Show ToolBar Tips option is selected a small popup tip window will appear when the mouse pointer is placed over a
button. A short description of what each button does can be viewed using this method.



Shortcut Keys

Shortcuts
Shortcut keys allow you to quickly invoke Icon Extractor menu commands without first displaying the menu and then selecting an
item from it. The most commonly used Icon Extractor commands can be invoked using the following shortcut keys.

File Menu
Ctrl+O Open an existing icon file
Alt+Enter Show properties for the current icon file
Ctrl+W Close the current icon file
Ctrl+S Save selected icon as an ICO file
Ctrl+Q Exit Icon Extractor, and return to the desktop
Edit Menu
Ctri+C Copy the currently selected icon to the Clipboard
CtrI+E Open the default Icon Editor
View Menu
PgUp Display the previous page of icons
PgDn Display the next page of icons
Ctri+Y Minimize Icon Extractor to a button or icon
Ctrl+T Make the Icon Extractor window topmost
Help Menu

F1 Display this Help file



Comments and Upgrades

Comments and Suggestions
If you have comments, questions or find any bugs in Icon Extractor for Windows 95/NT please feel free to contact me on
CompusServe.

Gregory Braun

CompusServe: 71613,2175

Email: 71613.2175@compuserve.com
Web Site: http://www.execpc.com/~shd
Phone: 1.414.444.8497

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

-Software by Design Web Site

(http://www.execpc.com/~sbd)



Release History

Icon Extractor for Windows 95/NT Release History

v2.0

v2.1

v2.2

v2.3

v2.4

v2.5

v2.5

v2.6

v2.7

v2.8

v2.9

v3.0

Original in-house development and testing of MS Windows 95/NT conversion using the Microsoft Win32 SDK.
Added 95/NT splash box for release.
Added an option to allow multiple instances to be launched.

Added options to place the program icon in the Taskbar notification tray, and to play an SLR camera shutter sound when
copying icons to the MS Widows Clipboard.

Added support for screen color settings as specified by the Display Properties dialog. Added default user and company
names to the splash box.

Added an option to specify a custom background color for Clipboard copies.

Implemented a drag & drop interface to quickly load and view icon files. Moved all ICONEX.INI configuration settings to
the MS Windows 95/NT System Reqistry. Added an MS Windows Explorer Setup facility. Added MS Windows 95/NT
Help file. Fixed several minor bugs.

Fixed several minor bugs.

Converted the Icon Extractor dialog box to a three-tab property sheet. Fixed a bug that prevented proper window
repositioning when the MS Explorer Taskbar was placed along the left edge or at the top of the desktop and the Auto

Hide option was active.

Added a Recent Files sub-menu to the Eile Menu. Added facilities to the Icon Extractor Options dialog box to define a
custom Icon Editor. Fixed several minor bugs.

Added a progress bar when loading icons from a selected file. Icon Extractor now behaves like a true Taskbar Tray
application when the Place Icon in the Taskbar Tray option is selected. Several other minor bugs have been fixed.

Fixed several minor bugs.

Last Update March 11th, 1998

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

B

oftware by Design Web Site

(http://www.execpc.com/~sbd)



System Registry

Icon Extractor for Windows 95/NT System Registry Key
Icon Extractor for Windows 95/NT stores configuration settings in the MS Windows 95/NT System Registry. These settings are
updated automatically while Icon Extractor is running. There is no need to edit these settings manually.

If you insist upon editing these settings, you do so at your own risk. Ilcon Extractor automatically updates registry entries when it
exits. If you edit these settings make sure Icon Extractor is not running while you edit them. If Icon Extractor is currently running
your changes will be overwritten when Icon Extractor exits.

Icon Extractor for Windows 95/NT stores configuration settings in the following system registry key:

HKEY_CURRENT_USER
Software
Software by Design
Icon Extractor for Windows 95/NT
Section
Label = Value

Warning There is no need to edit these settings manually. Icon Extractor will automatically maintain these settings for you. If you
do edit these, you do so at your own risk.



Removing Icon Extractor

Removing Icon Extractor for Windows 95/NT

If you find that Icon Extractor for Windows 95/NT does not meet your needs you can remove it from your computer system by
simply deleting the following files from your hard drive. All of these files will be located in the folder that you originally installed
Icon Extractor in.

IconEx.exe Icon Extractor application program.
IconEx.cnt Icon Extractor Help Topics File
IconEx.hlp Icon Extractor Help File

If you have opened and used the Icon Extractor for Windows 95/NT Help files your system may contain the following two (2)
files. These files are created by the standard MS Windows 95/NT Help program WinHIp32.exe. These files may also be safely
removed.

IconEx.gid MS Windows Help settings file. This file contains the Icon Extractor Help window size and desktop location
as well as any bookmarks you may have created.

IconEx.fts MS Windows Help word database. This file is created when you build a custom word list for Icon Extractor
Help files. This file is used to search for words and phrases in the Icon Extractor Help files.

Icon Extractor for Windows 95/NT does not use any custom DLL files or system drivers. If you delete the files mentioned above
from your system’s hard drive you will have completely removed Icon Extractor from your computer system.

Note If you have installed Icon Extractor shortcuts on the MS Explorer Start Menu use the Help | Setup command to remove the
shortcuts you created before you delete the Icon Extractor files mentioned above.



Software by Design Web Site

Software by Design
You can download the latest versions of all of my software from my web site on the Internet. | post the latest releases of my
software there first. Click your mouse on the link listed below to visit the Software by Design web site.

-Software by Design Web Site

(http://www.execpc.com/~sbd)

Software Titles
The following software titles are available at my web site on the Internet and can also be found on CompuServe, ExecPC, MSN

and ZD Net.

NoteBook for Windows (NBOOK.ZIP)
NoteBook for Windows 95/NT (NBOOK32.ZIP)
Reminders for Windows (REMIND.ZIP)
Reminders for Windows 95/NT (REMIND32.ZIP)
ToolBar for Windows (TBAR.ZIP)
ToolBar for Windows 95/NT (TBAR32.ZIP)
Screen Loupe for Windows (LOUPE.ZIP)

Screen Loupe for Windows 95/NT
Screen Loupe for Macintosh

(LOUPE32.ZIP)
(LOUPE.SEA)

Audition for Windows 95/NT (AUDITION.ZIP)
Password Keeper for Windows 95/NT (PASSKEEP.ZIP)
CardBase for Windows 95/NT (CARDBASE.ZIP)
File Editor for Windows (FXEDIT.ZIP)

File Editor for Windows 95/NT (FXEDIT32.ZIP)
Crypto for Windows 95/NT (CRYPTO.ZIP)
Icon Extractor for Windows (ICONX.ZIP)

Icon Extractor for Windows 95/NT (ICONX32.ZIP)
TxEdit for Windows 95/NT (TXEDIT.ZIP)
DLL Show for Windows 95 (DLLSHOW.ZIP)
RGB Editor for Windows (RGB.ZIP)

RGB Editor for Windows 95/NT (RGB32.ZIP)
Quiz Wizard for Windows 95/NT (QUIZWIZ.ZIP)
FontShow for Windows 95/NT (FONTSHOW.ZIP)
Programmer's IDE (PMAN.ZIP)

Programmer's IDE 95/NT

Touch for Windows

Disk CleanUp for Windows 95/NT
BattleStar for Windows

BattleStar for Windows 95/NT
World Radio for Macintosh

Note The latest versions of my software programs are always posted on my web site first. Versions found on the other online

services may be earlier releases.

(PMAN32.ZIP)
(WTOUCH.ZIP)
(CLEANUP.ZIP)
(BSTAR.ZIP)

(BSTAR32.ZIP)
(WRADIO.SEA)



BBS and Internet Operators

Webmasters
Please upload the original ZIP file intact and title the submission:

"Icon Extractor for Windows 95/NT v3.0"
--Author Gregory Braun

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

-Software by Design Web Site

(http://www.execpc.com/~sbd)

Note This site also supports anonymous FTP transfers.



What is Shareware

The concept of "Shareware"...

Shareware, also known as user supported software and other names, is a concept not understood by everyone. The author of
Shareware retains all rights to the software under the copyright laws while still allowing free distribution. This gives the user the
chance to freely obtain and try out software to see if it fits their needs. Shareware should not be confused with Public Domain
software even though they are often obtained from the same sources.

If you continue to use Shareware after trying it out, you are expected to register your use with the author and pay a registration
fee. What you get in return depends on the author, but may include a printed manual, free updates, telephone support, etc. Only
by paying for the Shareware you use do you enable the Shareware author to continue to support his software and create new
programs. Considering that the Shareware registration fees are almost always far less than the purchase price of comparable
commercial software it's obvious that Shareware is a good deal for everyone.

There are real advantages to you in the Shareware system. You get to try out software to make sure it is compatible with your
hardware and that it fits your needs before you "buy" it with your registration. The author saves the expense of advertising,
packaging and distribution and passes the savings on to you. Plus, most Shareware authors are much more accessible than
commercial software sources so that your questions and suggestions are much more likely to be responded to.

Thank you for your support.



Registering Icon Extractor for Windows 95/NT

Registering Icon Extractor

Icon Extractor for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days if
you continue to use Icon Extractor for Windows 95/NT you are required to register it. If after evaluating Icon Extractor for 30 days
you decide not to register it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register Icon Extractor for Windows 95/NT by mailing the Order Form provided with this software. When you register
Icon Extractor for Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your
registration code be mailed to you.

The software you are currently using is a fully functioning program. There are no time limitations built into the software to restrict
its continued use and no program features have been disabled. As a registered user you will however be able to disable the
initial splash box that appears when Icon Extractor for Windows 95/NT is first launched.

To register your copy of Icon Extractor for Windows 95/NT select the Help | Register menu command. The Shareware
Registration Wizard will be displayed when this menu command is selected. Use this window to fill in the following entry fields:

User Name
Enter the user name you originally specified when you ordered Icon Extractor for Windows 95/NT.

Organization
Enter the name of your organization as originally specified when you ordered Icon Extractor for Windows 95/NT. If you did not
specify an organization name leave this field blank.

Registration
Enter the registration code that was provided to you. Enter your registration code exactly as provided. Do not include spaces
when entering your registration code.

Note The registration code was provided to you when you purchased Icon Extractor for Windows 95/NT. Refer to the
notification letter that was mailed to you or the E-Mail message you received for your personal shareware registration code.

Show Splash Box at Startup
This box will be initially checked if you have not registered Icon Extractor for Windows 95/NT. When you successfully register
your copy of Icon Extractor this box will automatically be unchecked for you. If you wish to see the splash box when Icon
Extractor is launched return to this Registration Wizard and check this box.

OK
Press this button after you have filled out the Shareware Registration Wizard to complete Icon Extractor for Windows 95/NT
shareware registration.

Cancel
Press this button to close the Shareware Registration Wizard without making any changes.

Help
Press this button to open the Icon Extractor Help window and go directly to the Registering Icon Extractor topic.



Purchasing Information

Purchasing Information

Icon Extractor for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days if
you continue to use lcon Extractor for Windows 95/NT you are required to register it. If after evaluating Icon Extractor for 30 days
you decide not to purchase it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register Icon Extractor for Windows 95/NT by mailing the Order Form provided with this software. When you register
Icon Extractor for Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your
registration code be mailed to you.

The software you are currently using is a fully functioning program. There are no time limitations built into the software to restrict
its continued use and no program features have been disabled. As a registered user you will however be able to disable the
initial splash box that appears when Icon Extractor for Windows 95/NT is first launched.

Single User Licensing

Individual users can register Icon Extractor for Windows 95/NT for $20.00 dollars. If you would also like a 3 2 floppy disk sent
to you please add an additional $5.00 dollars. Registration entitles you to unlimited free updates and telephone support. You can
always download the latest release of Icon Extractor directly from the Software by Design web site on the Internet. Print the Icon
Extractor for Windows 95/NT Order Form and mail it with your check to become a registered user of Icon Extractor for Windows
95/NT.

Site Licensing

Icon Extractor for Windows 95/NT can also be registered for use at an entire site for $250.00 dollars. If you would like to install
and use Icon Extractor on multiple workstations at a single location choose this type of licensing. Registration includes a 3 %%”
floppy disk and entitles you to unlimited free updates and telephone support. You can always download the latest release of Icon
Extractor directly from the Software by Design web site on the Internet. Print the Icon Extractor for Windows 95/NT Order Form
and mail it with your check to become a registered user of Icon Extractor for Windows 95/NT.

Corporate Licensing

Icon Extractor for Windows 95/NT can also be registered for use at multiple sites for $1000.00 dollars. If you would like to install
and use Icon Extractor on multiple workstations at multiple locations choose this type of licensing. Registration includes a 3 2"
floppy disk and entitles you to unlimited free updates and telephone support. You can always download the latest release of Icon
Extractor directly from the Software by Design web site on the Internet. Print the Icon Extractor for Windows 95/NT Order Form
and mail it with your check to become a registered user of Icon Extractor for Windows 95/NT.



Icon Extractor for Windows 95/NT Order Form
To print this order form, press the Print button above, or select Print Topic from the File pull-down menu.
To order by check, send this order form and a check to:
Gregory Braun
5609 West Hadley Street
Milwaukee, WI 53210-1554 U.S.A.
Payments must be in US dollars drawn on a US bank, or you can send international postal orders in US dollars.
All orders are subject to the License Agreement.

Customer information is considered confidential and will not be shared or distributed to any third parties.

Registered users of Icon Extractor for Windows 95/NT are entitled to unlimited free program updates.

Single User Copy at  $20.00 each =
Optional 3 %2 Disk at  $5.00 each =
Site License at  $250.00 each=

Includes 3 %" Disk
Corporate License at  $1000.00 each =

Includes 3 ¥ Disk
Wisconsin Residents add 5.5% sales tax:
Total Payment:

Date

Name

Organization

Shipping Address

City

State

Zip Code

Country

Day Phone

E-Mail Address

[ ]Please send registration code via E-Mail

Comments:



License Agreement

License Agreement
You should carefully read the following terms and conditions before using this software. Unless you have a different license
agreement signed by Gregory Braun, your use of this software indicates your acceptance of this license agreement and
warranty.

Registered Version
One registered copy of Icon Extractor for Windows 95/NT may either be used by a single person who uses the software
personally on one or more computers, or installed on a single workstation used nonsimultaneously by multiple people, but not
both.

Site License
Any number of users at a single location may access the registered version of Icon Extractor for Windows 95/NT through a
network, provided that you have obtained a site license for the software covering all workstations that will access the software
through the network. Any number of users at a single location can install and use the software on one or more computers or
workstations.

Corporate License
Any number of users at any number of locations may access the registered version of Icon Extractor for Windows 95/NT
through a network, provided that you have obtained a corporate license for the software covering all workstations that will
access the software through the network. Any number of users at any number of locations can install and use the software on
one or more computers or workstations.

Software Updates
Registered users of Icon Extractor for Windows 95/NT are entitled to unlimited free program updates. Software updates can
be downloaded directly from the Software by Design web site on the Internet.

Governing Law
This agreement shall be governed by the laws of the State of Wisconsin.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS TO
PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED. NO
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data before relying on it. The
user must assume the entire risk of using the program. ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY
TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.






